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Important Information

Warranty

The FieldPoint FP-1000 and FP-1001 network modules are warranted against defects in materials and workmanship 
for a period of one year from the date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period. This 
warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do 
not execute programming instructions if National Instruments receives notice of such defects during the warranty 
period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping 
costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully 
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves 
the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The 
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for 
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND 
SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS 
WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National 
Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action 
against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided 
herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the 
National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or 
other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, 
without the prior written consent of National Instruments Corporation.

Trademarks

BridgeVIEW™, CVI™, FieldPoint™, LabVIEW™, Lookout™, and natinst.com™ are trademarks of National 
Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving 
medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the 
part of the user or application designer. Any use or application of National Instruments products for or involving 
medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all traditional 
medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent serious injury 
or death should always continue to be used when National Instruments products are being used. National Instruments 
products are NOT intended to be a substitute for any form of established process, procedure, or equipment used to 
monitor or safeguard human health and safety in medical or clinical treatment.
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Organization of This Manual

This manual is organized as follows:

• Chapter 1, FP-1000/1001 Network Module Overview, provides an 

overview of the FieldPoint network modules.

• Chapter 2, Hardware Installation and Configuration, describes 

how to install and configure your FieldPoint FP-1000 or FP-1001 

network module, connect it to an RS-232 or RS-485 network, and 

connect power to the network module.

• Chapter 3, Feature Set Description, describes the feature set for the 

FP-1000 and FP-1001 network modules.

• Chapter 4, Installing and Using the FieldPoint Software, describes 

how to use the FieldPoint hardware with various servers and 

software packages.

• Appendix A, Specifications, describes the specifications of the 

FP-1000 and FP-1001 network modules.

• Appendix B, Customer Communication, contains forms you can 

use to request help from National Instruments or to comment on our 

products and manuals.

• The Glossary contains an alphabetical list and description of terms 

used in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in 

this manual, including the page number where you can find each 

one.

Conventions Used in This Manual

The following conventions are used in this manual:

This icon to the left of bold italicized text denotes a note, which alerts 

you to important information.

This icon to the left of bold italicized text denotes a caution, which 

advises you of precautions to take to avoid injury, data loss, or a 

system crash.

bold Bold text denotes the names of menus, menu items, parameters, dialog 

box, dialog box buttons or options, icons, windows, Windows 95 tabs, 

or LEDs.

bold italic Bold italic text denotes a note or caution.

!
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italic Italic text denotes emphasis, a cross reference, or an introduction to a 

key concept. This font also denotes text from which you supply the 

appropriate word or value, as in Windows 3.x.

italic monospace Italic text in this font denotes that you must supply the appropriate 

words or values in the place of these items.

FP-1000/1001 Refers to the FP-1000 network module and/or the FP-1001 network 

module, in cases where the text applies to both modules. Any specific 

differences are noted.

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and 

syntax examples. This font is also used for the proper names of disk 

drives, paths, directories, programs, subprograms, subroutines, device 

names, functions, operations, variables, filenames and extensions, and 

for statements and comments taken from programs.

Related Documentation

The following documents contain information that you may find helpful 

as you read this manual:

• Operating Instructions (for network module, terminal bases, and 

I/O modules)

• FieldPoint Server online help

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make 

it easy for you to contact us, this manual contains comment and 

configuration forms for you to complete. These forms are in 

Appendix B, Customer Communication, at the end of this manual.
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Chapter

1FP-1000/1001 Network 
Module Overview

This chapter provides an overview of the FieldPoint network modules.

Capabilities of the Network Modules

A FieldPoint system consists of at least one network module, at least 

one terminal base, and one or more I/O modules.

The FP-1000 FieldPoint network module connects an industrial RS-232 

network to FieldPoint I/O modules. The FP-1001 FieldPoint network 

module connects an industrial RS-485 network to FieldPoint I/O 

modules. 

Figure 1-1 shows the FP-1000 and FP-1001 network modules.

Figure 1-1.  FP-1000 and FP-1001 Network Modules
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The FP-1000/1001 supports standard commands (subset of Optomux 

command set) and a set of extended commands to completely support 

the FieldPoint I/O modules. Both network modules can co-exist with 

other Optomux devices on the same network.

The FP-1000/1001 uses the Optomux protocol. Therefore, after you 

have configured the FieldPoint bank (network module and I/O 

modules), you can use any application software that supports Optomux 

to communicate with FieldPoint modules in the bank.

In a distributed application, many FieldPoint banks are networked 

together. You can network up to 25 FieldPoint banks to each 

RS-232/RS-485 port of your host computer. Each bank can contain up 

to nine I/O modules, thus connecting up to 225 I/O modules per RS-232 

(or RS-485) port in your host computer. You can further increase your 

field I/O count by using more RS-232/RS-485 ports in your host 

computer.

FP-1000 Connects to RS-232

The FP-1000 connects directly to the RS-232 port that is available on 

most host computers. Because RS-232 is a point-to-point network that 

allows connection to only one device, the FP-1000 provides an RS-485 

repeater so that you can build a network with multiple FieldPoint banks 

by connecting one or more FP-1001s to a single FP-1000. 

FP-1001 Connects to RS-485

The FP-1001 FieldPoint network module connects directly to any 

RS-485 adapter card installed in your host computer, or to the RS-485 

repeater port of an FP-1000. Because RS-485 is inherently a multidrop 

network, the FP-1001 does not provide a separate RS-485 repeater. You 

can network multiple FP-1001 modules in multidrop fashion.

The FP-1001 communicates over RS-485, utilizing full-duplex mode. It 

is optically isolated, which prevents fault coupling between the RS-485 

network and the FP-1001. 
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Chapter

2Hardware Installation and 
Configuration

This chapter describes how to install and configure your FieldPoint 

FP-1000 or FP-1001 network module, connect it to an RS-232 or 

RS-485 network, and connect power to the network module.

Mounting the FP-1000/1001 and Terminal Bases

You can choose either of two methods of securely mounting a 

FieldPoint system: DIN rail mounting or direct panel mounting. 

Mounting directly to a panel is generally the more secure of the 

two options, but DIN rail mounting may be more convenient in your 

application. The following sections give instructions for both mounting 

methods.

Mounting the FP-1000/1001 on a DIN Rail
The FieldPoint network modules have rugged, simple clips for reliable 

mounting onto a standard 35 mm DIN rail. Follow these steps to mount 

the FP-1000/1001 network module onto a DIN rail.

1. Use a flat-bladed screwdriver to open the DIN rail clip to the 

unlocked position, as shown in Figure 2-1.

Figure 2-1.  DIN Rail Clip in the Unlocked Position

2. Hook the lip on the rear of the network module onto the top of a 35 mm 

DIN rail and press the network module down onto the DIN rail as 

shown in Figure 2-2.

Rail Clip Locked Rail Clip Unlocked
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Figure 2-2.  Installing the FP-1000/1001 Network Module onto a DIN Rail

3. Slide the network module to the desired position on the DIN rail. After 

the module is in position, push the rail clip into the locked position to 

lock the module in place on the DIN rail, as shown in Figure 2-3.

Figure 2-3.  Locking the FP-1000/1001 Network Module onto a DIN Rail

After the network module is installed, connect the terminal base to the 

network module as explained in the next section, Connecting Terminal 

Bases with DIN Rail Mounting.
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Connecting Terminal Bases with DIN Rail Mounting
Follow these steps to connect a terminal base to an FP-1000/1001 

network module when you are using DIN rail mounting.

Note: Ensure that power is not applied to the network module before you install 

or remove terminal bases.

1. Remove the protective cover from the network module’s local bus 

connector (see Figure 2-2) or from the bag of accessories that came 

with your network module.

2. Install the terminal base onto the DIN rail in the same way you 

installed the network module. 

3. Attach the terminal base to the network module by firmly mating 

the local bus connectors. 

4. To add more terminal bases, install them on the rail and connect 

their local bus connectors together.

5. Place the protective cover onto the last terminal base on the bank, 

as shown in Figure 2-4. 

Figure 2-4.  Connecting Terminal Bases
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Removing the FP-1000/1001 from the DIN Rail
To remove an FP-1000/1001 network module, unlock it from the DIN 

rail by placing a screwdriver in the slot on the rail clip and opening it to 

the unlocked position as shown in Figure 2-1. 

Then, disconnect the module from the local bus connector of the 

terminal base, and lift the module off of the rail.

Mounting the FP-1000/1001 to a Panel
Perform the following steps to install the optional FieldPoint network 

panel mount accessory and mount the FP-1000/1001 network module. 

You can order the panel mount accessory, part number 777609-01, from 

National Instruments.

1. Make sure that the rail clip on the network module is unlocked. 

Figure 2-5 shows a FieldPoint network module and the locked and 

unlocked positions of the rail clip. 

Figure 2-5.  FieldPoint Network Module

2. Snap the panel mount accessory onto the module as shown in 

Figure 2-6.
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Figure 2-6.  Installing the Network Panel Mount Accessory

3. Press on the rail clip to lock it. The locked position is shown in 

Figure 2-5.

4. Mount the network module with the panel mount accessory. The 

installation guide that came with the panel mount accessory 

includes a guide you can use to drill pilot holes for mounting the 

module.

Connecting Terminal Bases with Panel Mounting
The terminal bases can be directly installed without using the panel 

mount accessory that is needed for mounting the FP-1000/1001 network 

module. Follow these steps to connect terminal bases to a network 

module when you are using panel mounting.

Note: Ensure that power is not applied to the network module before you install 

or remove terminal bases.

1. Remove the protective cover from the network module’s local bus 

connector (see Figure 2-5).

2. Drill pilot holes in the panel to mount the terminal bases. A drilling 

guide is provided with the network module panel mount accessory.

3. Attach the terminal base to the network module by firmly mating 

the local bus connectors.

Press
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4. Bolt, screw, or otherwise fasten the terminal base to the panel. 

Ensure that the local bus connectors remain firmly mated after the 

terminal base is mounted.

5. To add more terminal bases, repeat Steps 2 through 4, mating the 

local bus connectors of each new terminal base to the connector of 

the last installed base. If all the pilot holes were correctly drilled, 

the local bus connectors should all remain firmly mated after all the 

bases are mounted to the panel.

6. Place the protective cover that you removed from the network 

module in Step 1 onto the local bus connector of the last terminal 

base on the bank.

Removing the FP-1000/1001 and Terminal Bases 
from the Panel
To remove the FP-1000/1001 network module and terminal bases from 

the panel, reverse the process described in the previous sections, 

Mounting the FP-1000/1001 to a Panel and Connecting Terminal Bases 

with Panel Mounting. First remove the terminal bases, starting with the 

last one, then remove the network module.

Installing I/O Modules onto Terminal Bases

To connect an I/O module, install it onto a terminal base. Refer to 

Figure 2-7 and follow these steps: 

1. Position the first module with its alignment slots aligned with the guide 

rails on the terminal base.

2. Press firmly to seat the module on the terminal base. The terminal base 

latch locks the I/O module into place when the module is firmly seated.

3. To connect additional I/O modules, repeat the procedure to install them 

onto additional terminal bases.
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Figure 2-7.  Module Installation Diagram

Connecting the FP-1000 to Your Computer

This section describes the network configurations possible with the 

FP-1000 network module.

Connect the RS-232 port of the FP-1000 to your host computer’s 

RS-232 port. Use a 9-pin DSUB male-to-female straight-through cable. 

Do not use a null modem cable (usually female-to-female). 

You can connect only one FP-1000 for each RS-232 port in your host 

computer. You can add more FieldPoint banks without using more 

RS-232 ports of your host computer, by connecting one or more (up 

to 24) FP-1001 network modules to the RS-485 repeater port of the 

FP-1000. This network configuration is shown in Figure 2-8. 

Figure 2-8.  Host Computer Connected to One FP-1000 and

Two FP-1001 Network Modules
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The RS-485 repeater port on the FP-1000 must always be wired in 

4-wire, full-duplex mode.

RS-232 Interface Specifications
RS-232 specifies a maximum cabling distance of 50 ft., but 

improvements in line drivers and cabling technology often allow you to 

design your network beyond the recommendations of the specification.

The RS-232 connector is 9-pin female DSUB connector whose pinout 

is shown in Figure 2-9. 

Figure 2-9.  RS-232 Connector Pinout for the FP-1000

The FP-1000 does not use RS-232 hardware handshaking, but it still 

asserts the RTS and DSR signals for host computers or software that 

may require these signals. A host computer that does not use these 

signals does not need to connect to them.

Connecting the FP-1001 to the Serial Network

This section describes the network configurations possible with the 

FP-1001 FieldPoint network module. 

One option for connecting the FP-1001 is to connect it to the RS-485 

repeater port of an FP-1000 as shown in Figure 2-8. The RS-485 port on 

the FP-1001 must be wired in 4-wire, full duplex mode when connected 

to the RS-485 repeater port. 
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An alternative method is to connect the FP-1001 directly to your host 

computer, if your host computer provides an RS-485 interface. Contact 

National Instruments for information about available RS-485 hardware. 

You can connect up to 25 FP-1001 network modules to each RS-485 

port on the host computer. This network configuration method is shown 

in Figure 2-10.

Figure 2-10.  Host Computer Connected to Three FP-1001 Network Modules

When the FP-1001 is cabled directly to an RS-485 port on a host 

computer, as shown in Figure 2-10, you can wire it in either 4-wire full 

duplex mode or 2-wire half duplex mode. 

The multidrop topology used by the RS-485 network in these two 

networking configurations protects against power failures at individual 

FieldPoint banks. It eliminates the possibility that a power failure at one 

FP-1001 bank might affect the communication between other banks in 

your network. Because the FP-1000 provides an RS-485 repeater, a 

power failure at that bank affects communications.

Caution: Do not use the isolation barrier of the RS-485 interface as a way to protect 

human contact from common-mode voltages of more than 250 Vrms. The 

RS-485 interface on both the FP-1000 and the FP-1001 modules is isolated 

from the rest of the FieldPoint system, including the power supply, 

backplane, and the RS-232 interface on the FP-1000. It is isolated with a 

galvanic and optical isolation barrier, which has been designed and tested 

to withstand fault voltages of up to 2500 Vrms. However, the safety rating 

of this barrier is only for working voltages of up to 250 Vrms. Also note that 

while the RS-232 interface on the FP-1000 is isolated from the RS-485 

Host Computer with
RS-485 Board Installed

FP-1001FP-1001FP-1001

RS-485

!
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interface, it is NOT isolated from the power supply inputs (the V and C 

terminals).

RS-485 Interface Specifications
RS-485 specifies a maximum cabling distance of 4000 ft., but 

improvements in line drivers and cabling technology often allow you to 

design your network beyond the recommendations of the specification. 

If even longer distances are desirable, you can use RS-485 repeaters.

An RS-485 stub is created when you tap the RS-485 backbone to form 

a T-junction. RS-485 stubs must be less than 3 in. long. However, you 

can create longer stubs by using an RS-485 repeater to start the stub, 

ensuring that the repeater is close to the junction.

The RS-485 connector is a 5-pin Combicon connector whose pinout is 

shown in Figure 2-11. 

Figure 2-11.  RS-485 Connector Pinout for the FP-1000 and FP-1001

RS-485 Network Termination and Biasing
An RS-485 network must be terminated at each end of the network, but 

not anywhere else. At each end bank, termination resistors should be 

installed between the RX pair and between the TX pair. These network 

terminating resistors are nominally 120 Ω and are provided in your kit. 

To install them, twist the resistor leads with the RS-485 signal wires and 

then insert them into the RS-485 Combicon adapter as shown in 

Figure 2-12. The 120 Ω resistor in the figure is a terminating resistor.
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Figure 2-12.  Terminating RS-485 Using the Combicon Adapter

An RS-485 network also needs biasing resistors to protect the devices 

on the network against noise during intervals when no RS-485 drivers 

are transmitting on the network. The host computer’s RS-485 interface 

normally has provision for such biasing resistors. When you are using 

FP-1001 network modules directly connected to a host computer’s 

RS-485 interface, you should use the biasing feature of the host 

computer’s RS-485 interface for better reliability and noise immunity. 

The RS-485 repeater interface on the FP-1000 already has biasing 

resistors, so you do not need to do anything when connecting one or 

more FP-1001 modules to the FP-1000.

Figures 2-13 and 2-14 show typical RS-232 and RS-485 signal 

connections and termination for a FieldPoint network. Figure 2-13 is a 

more detailed depiction of Figure 2-8, and Figure 2-14 is a more 

detailed depiction of Figure 2-10.

Figure 2-13.  Typical Signal Connections for Host Computer Connected
to One FP-1000 and Multiple FP-1001 Network Modules
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Connect the TX outputs of the FP-1001 to the RX inputs of the FP-1000,
and the RX inputs of the FP-1001 to the TX outputs of the FP-1000.
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Figure 2-14.  Typical Signal Connections for Host Computer Connected
to Multiple FP-1001 Network Modules

Configuring the FP-1000/1001

Figure 2-15 shows the 8-position switch on the FP-1000/1001 network 

module. Switches 1–5 set the network address, and switches 6–8 set the 

baud rate.

Figure 2-15.  Address and Baud Rate Switch
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Connect the TX outputs of the host computer to the RX inputs of the FP-1001,
and the RX inputs of the host computer to the TX outputs of the FP-1001.
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The FP-1000/1001 is preconfigured for network address 0 and a baud 

rate of 115.2 kbps. If you are connecting only a single network module, 

you do not need to change the network address from the preconfigured 

setting of address 0. You should not need to change the baud rate setting 

unless you are experiencing communication problems.

Follow these steps if you need to change the address and baud rate for 

your FP-1000/1001 network module.

1. Choose and set a network address. Refer to the following section, 

Setting the Network Address, for more information.

2. Choose and set the baud rate. For more information, refer to the 

Setting the Baud Rate section, later in this chapter.

3. Write your address and baud rate settings in the space provided on 

the FP-1000/1001 label.

4. Apply (or cycle) power to the bank, to enable the FP-1000/1001 for 

the new network address and baud rate.

5. Make the same address and baud rate changes in your FieldPoint 

software. Refer to Step 4 in the Getting Started with FieldPoint 

Explorer section of Chapter 4, Installing and Using the FieldPoint 

Software, for more information.

Setting the Network Address

Note:  If you are connecting only a single FP-1000/1001 network module, you do 

not need to change the network address from the preconfigured setting of 

address 0. If you are connecting more than one network module to the 

same host computer port, ensure that each network module has a unique 

address.

Switches 1–5 set the network module address. The addresses of the 
terminal bases in a FieldPoint bank are automatically configured by the 
network module to be sequentially higher than the network module’s 
address. For example, if the network module is set to address 20, the I/O 
module in the terminal base adjacent to the network module is at 
address 21, the next I/O module is at address 22, and so on. A terminal 
base is assigned an address whether an I/O module is inserted on it or 
not. The network module’s address is determined by the settings of the 
switches when the modules is powered on. If the switch settings are 
changed while the module is powered, the module must be powered off 
then on again before the new settings are applied.

Table 2-1 shows the possible switch positions and the corresponding 

address of the FieldPoint network module. 
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Table 2-1.  Network Address Switch Settings for the FP-1000/1001

Switch

Positions 1–5

Network Module 

Address (Decimal)

Switch

Positions 1–5

Network Module 

Address (Decimal)

0 130

10 140

20 150

30 160

40 170

50 180

60 190

70 200

80 210

90 220

100 230

110 240

120 Other Settings Not Allowed

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8
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Setting the Baud Rate
Switches 6–8 set the network module baud rate. Table 2-2 shows the 

switch positions and the corresponding network baud rates of the 

FP-1000/1001 network module. The network module’s baud rate is 

determined by the settings of the switches when the module is powered 

on. If the switch settings are changed while the module is powered, the 

module must be powered off then on again before the new settings are 

applied.

Note: The preconfigured setting of 115.2 kbps should provide the fastest 

performance, and you should not need to change this setting unless you are 

experiencing communication problems. If you are connecting more than 

one network module to the same host computer port, ensure that every 

network module’s baud rate setting is identical.

The serial interface on the FP-1000/1001 always uses the following 

parameters: 1 start bit, 8 data bits, 1 stop bit, and no parity.

Connecting Power to the FP-1000/1001

An 11–30 VDC power supply is required by each FieldPoint network 

module. The network module filters and regulates this supplied power 

and provides power for all the I/O modules in the bank. Therefore you 

need not provide power separately to each FieldPoint I/O module in 

the bank. 

Table 2-2.  Baud Rate Switch Settings for the FP-1000/1001

Switch

Positions 6–8

Network Module 

Baud Rate

Switch

Positions 6–8

Network Module 

Baud Rate

300 19200

1200 38400

2400 57600

9600 115200

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8
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The power connector is a 4-pin screw terminal connector whose pinout 

is shown in Figure 2-16. 

Figure 2-16.  FP-1000/1001 Power Connector Pinout

The two terminals labeled V are internally connected on the network 

module, as are the two terminals labeled C. Power must be applied to 

one V and C pair for operation of the FieldPoint bank. If you want to 

power your field I/O devices from the same power supply, the second 

V and C pair provides a convenient means of connecting power to the 

V and C terminals of a terminal base. Figure 2-16 shows this optional 

connection.

If your field I/O devices need to be powered separately, you can use the 

terminals provided on each terminal base for such power supply 

connections. Refer to the documentation that came with your terminal 

base and I/O module for more information on powering your field I/O 

devices.

Calculating Power for a FieldPoint Bank
The power requirements for a FieldPoint bank that uses an 

FP-1000/1001 network module are calculated as follows:

Power = 1 watt + 1.15 * ∑(I/O Module Consumption)

This is the amount of power the network module consumes from the 

power supply to power itself and the I/O modules. It does not include 

any power consumed by devices that you wire to the terminal bases.

The operating instructions for each FieldPoint I/O module contain 

power consumption information.

V V

C C

+ V

C
–

To Power Supply
To Adjacent Terminal Base
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Completed Hardware Installation
When power is applied, the ACCESS and STATUS LEDs should flash 

once, and the POWER LED should stay lit. The POWER and READY 

LEDs should be lit on all of the I/O modules. If these LEDs are not lit, 

check your power connections and make sure that all of your modules 

and terminal bases are firmly mated. If the STATUS LED is blinking, 

refer to Table 3-2, STATUS LED Flashes and Corresponding Error 

Conditions, in Chapter 3, Feature Set Description.
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Chapter

3Feature Set Description

This chapter describes the feature set for the FP-1000 and FP-1001 

network modules.

High-Speed Local Bus

The FP-1000/1001 provides a high-speed local bus for communication 

to the I/O modules in the bank. The high-speed local bus has low 

overhead that enables fast response to commands from the host 

computer.

Network Watchdog Timer

The FP-1000/1001 can detect unexpected periods of network inactivity 

and respond to them in a user-defined way. The network watchdog 

timer feature enables you to guard your system against failures in the 

network connection, cables, or host computer, and to put the channel 

outputs in a user-defined state (the watchdog state) if such failures do 

occur.

You can set the watchdog output values to be different from the 

power-up output values. Some system applications do not differentiate 

between power-up output values and watchdog output values, while 

other applications treat the two conditions differently. The

FP-1000/1001 supports both types of applications.

By default, the watchdog timer for the bank is disabled on power up. To 

use the watchdog timer, set up the following parameters. You can use 

either the FieldPoint Explorer software or the FieldPoint command set.

• Watchdog data value for each channel

• Watchdog data enable/disable status for each channel

• Watchdog enabled/disabled status for each I/O module

• Watchdog timeout value for the bank
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Note: Each bank has only one watchdog timeout value that is common for all the 

modules in that bank. In addition, the current watchdog timeout value is 

not stored when you store the SnapShot.

SnapShot Feature

Many applications require that, upon startup, the system’s I/O modules 

power up with user-specified configuration and output levels rather 

than factory default settings. The SnapShot feature provides you with a 

single-step method to store the current state of your FieldPoint bank for 

use as the power-up state of the bank.

If you subsequently enable the SnapShot feature, you can ensure that 

your system powers up with the configuration and output levels that you 

specified when storing the SnapShot.

Prior to storing the SnapShot, you should bring all the channels to the 

desired power-up settings. You can use either the FieldPoint Server 

software or the FieldPoint command set to change the configuration of 

the FieldPoint bank, and then store the SnapShot. The SnapShot stores 

all the following information in a single step:

• Attribute and range settings of each channel.

• Output values of each channel.

• Watchdog data values of each channel. See the Network Watchdog 

Timer section in this chapter for more information.

• Watchdog data enabled (or disabled) status for each channel. See 

the Network Watchdog Timer section in this chapter for more 

information.

• Watchdog enabled (or disabled) status of each module. See the 

Network Watchdog Timer section in this chapter for more 

information.

After you store the SnapShot information, you can still choose whether 

the FP-1000/1001 uses that stored information during future power-ups. 

Enable the SnapShot feature if you want the FieldPoint bank to power 

up with the stored SnapShot information.

If you have enabled the SnapShot feature, the FP-1000/1001 restores 

the stored settings to all I/O modules and channels in the bank every 

time you power up, until you disable the SnapShot feature. If the 
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SnapShot feature is disabled, the FieldPoint bank powers up with 

factory-default settings.

At some time you might want to change the stored SnapShot 

information. To make incremental changes in the stored SnapShot 

information, you can use the features described in the next section, 

Programmable Power-Up State.

Note: The current watchdog timeout value for the FieldPoint bank is not saved 

when you store the SnapShot.

Note: The SnapShot feature inherently requires that the entire FieldPoint bank 

be at your desired power-up state, since when you store the SnapShot 

information, the current settings of the entire bank are stored for use at 

future power-ups.

Programmable Power-Up State

The SnapShot feature described in the SnapShot section provides you 

with a single-step method to store the current state of the FieldPoint 

bank for use as the power-up state. The FP-1000/1001 provides an 

alternative method to define power-up states that allows you to store the 

SnapShot information with more flexibility, as described in this section.

The Programmable Power-Up State feature enables you to define the 

power-up configuration on a module-by-module basis. In addition, you 

do not need to actually set any of the channels to the desired power-up 

state. You can therefore define the power-up states regardless of the 

current settings of any channel of a module.

Optionally, you can utilize the Programmable Power-Up State feature 

to incrementally modify previously stored SnapShot information.

If you subsequently enable the SnapShot feature, you can ensure that 

your system powers up with the configuration and output levels that you 

specified when storing the Programmable Power-Up States.
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You can use the Programmable Power-Up State feature to individually 

store the following information. You can use either the FieldPoint 

Explorer software or the FieldPoint command set.

• Attribute and range settings of each channel

• Output values of each channel

• Watchdog data value of each channel. See the Network Watchdog 

Timer section in this chapter for more information.

• Watchdog data enabled (or disabled) status for each channel. See 

the Network Watchdog Timer section in this chapter for more 

information.

• Watchdog timer enabled (or disabled) status of each module. See 

the Network Watchdog Timer section in this chapter for more 

information.

• Power-up watchdog timeout value for the FieldPoint bank

• The turn-around delay for each module

• The hot-swap reporting mode for the FieldPoint stack. See the next 

section, HotPnP (Hot Plug and Play), for more information on the 

hot-swap reporting mode.

If you have enabled the SnapShot feature, the FP-1000/1001 restores 

your desired settings to all I/O modules and channels in the bank every 

time you power up, until you disable the SnapShot feature. 

HotPnP (Hot Plug and Play)

The HotPnP feature simplifies system installation, configuration, and 

maintenance. With the HotPnP feature, you can remove or insert I/O 

modules into the FieldPoint terminal bases while power is on, even if 

the system is already engaged in network activity. You do not need to 

power down the entire system or even a bank to insert, remove, or 

replace I/O modules. In addition, you do not need to change the 

operation of the host computer or software to use the HotPnP feature.

When you insert an I/O module with the power on, it is automatically 

recognized, configured, and made available on the network. The 

following sections describe how the HotPnP feature works under 

different conditions.
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Note: You should not add or remove terminal bases while power is applied to the 

bank. An I/O module can be hot-inserted only if an empty terminal base is 

already available in the bank. 

HotPnP During Power-Up
Upon power-up, the FP-1000/1001 automatically uploads an electronic 

data sheet (EDS) from each I/O module in its bank. The FP-1000/1001 

then configures each I/O module in the bank to factory default settings 

in the module’s EDS, or stored SnapShot settings if the SnapShot 

feature is enabled.

HotPnP During Operation
You may need to insert or replace one or more I/O modules in a bank 

while your system is operational (power is on and the network may or 

may not be active).

Inserting New I/O Modules
When a new I/O module is inserted, the FP-1000/1001 automatically 

uploads the EDS and configures the I/O module to factory default 

settings in the module’s EDS, or to stored SnapShot settings if the 

SnapShot feature is enabled. This configuration is accomplished 

without any intervention from the host computer or software.

While one or more new I/O modules in a bank are being serviced by the 

HotPnP feature, the other I/O modules in the bank remain fully 

operational and accessible on the network without any interruptions. As 

soon as the FP-1000/1001 configures the new I/O module via the 

HotPnP service, that I/O module becomes automatically accessible on 

the network.

Replacing I/O Modules
When an I/O module is removed, the FP-1000/1001 does not undertake 

any special course of action for the bank. The host computer (or the 

software executing on it) may be unaware that the I/O module is 

missing, and may continue to send commands to the missing I/O 

module. Each command returns an error response, but the

FP-1000/1001 remembers the commands sent to the missing I/O 

module.
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When a new I/O module is connected in place of the one that was 

removed, the FP-1000/1001 first verifies that the replacement I/O 

module is compatible with the one that was removed. If the I/O module 

is the same as, or is compatible with, the one removed, the 

FP-1000/1001 configures the replacement I/O module with its 

predecessor’s configuration and output value settings. It also applies the 

effects of any commands sent by the host computer while the I/O 

module was missing.

If the replacement module is incompatible with the one that was 

removed, the FP-1000/1001 looks at the information stored in the 

SnapShot. If the SnapShot is enabled and the replacement module is 

compatible with the information in the SnapShot, the FP-1000/1001 

configures the replacement module with the SnapShot configuration. 

Otherwise, the FP-1000/1001 configures the replacement module to 

factory default settings.

Table 3-1 shows how modules are configured after HotPnP 

replacement.

While one or more replacement I/O modules in the bank are being 

serviced by the HotPnP feature, the other I/O modules in the bank 

Table 3-1.  Module Configuration Results After HotPnP Replacement

SnapShot 

Feature Replacement Module

Replacement Module 

Configuration After 

HotPnP

Enabled/

Disabled

Compatible with the 

removed module

Same as the configuration 

of the removed module

Disabled Incompatible with the 

removed module

Factory default 

configuration of 

replacement module

Enabled Incompatible with the 

removed module but 

compatible with the 

SnapShot information

Same as the configuration 

stored in the SnapShot

Enabled/

Disabled

Incompatible with the 

removed module and 

incompatible with the 

stored SnapShot 

information

Factory default 

configuration of 

replacement module
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remain fully operational and accessible on the network without any 

interruptions. As soon as the FP-1000/1001 configures a replacement 

I/O module via the HotPnP service, that I/O module becomes 

automatically accessible on the network.

Power-On Self Test (POST)

The power-on self test (POST) is a test suite that the FP-1000/1001 

performs at power up to verify its own operational status. The test is 

non-invasive and therefore does not affect the operation of the network, 

nor does it affect any of your field wiring connected to the terminal 

bases in the bank. 

If the self-test suite fails, the FP-1000/1001 does not participate in the 

network communication traffic, thereby eliminating potential conflicts 

with the other banks in your network. 

The FP-1000/1001 indicates POST failure via the STATUS LED. Refer 

to the next section, LED Indicators, for more information.

LED Indicators

The FP-1000/1001 has four LED indicators: POWER, NETWORK, 

ACCESS, and STATUS. Figure 3-1 shows the LEDs on the 

FP-1000/1001.

Figure 3-1.  LEDs on the FP-1000/1001
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The green POWER LED is lit while the FP-1000/1001 is powered up. 

This LED indicates that the power supply connected to the 

FP-1000/1001 is acceptable, and that the FP-1000/1001 is supplying 

power to the I/O modules.

The yellow NETWORK LED is lit during transmissions from the host 

computer on the network. This LED indicates that the FP-1000/1001 is 

receiving from the network, and that the communication wires to it are 

not broken. The NETWORK LED gets brighter as activity on the 

network increases.

The yellow ACCESS LED flashes when the FP-1000/1001 or any of the 

I/O modules in its bank respond to the host computer. This LED 

indicates that a module in the bank was addressed by a correctly 

formatted command, and that the module is responding to that 

command (either with a success or error response). 

The red STATUS LED is lit when the FP-1000/1001 detects a failure. 

If STATUS is not lit, the FP-1000/1001 has not detected a failure. The 

FP-1000/1001 indicates specific error conditions by flashing STATUS 

a specific number of times. Table 3-2 describes the STATUS LED 

flashing sequences and the corresponding error condition.

Table 3-2.  STATUS LED Flashes and Corresponding Error Conditions

Number of 

Flashes Error Condition

0 (stays lit) The FP-1000/1001 initialization failed.

1 The FP-1000/1001 address switch is incorrectly 

configured. Refer to the Setting the Network Address 

section in Chapter 2, Hardware Installation and 

Configuration.

2 The FP-1000/1001 has detected an error in the terminal 

bases in the bank or has identified a module in an illegal 

state. Verify that the protective cover is on the local bus 

connector of the last terminal base and that none of the 

pins of that connector are touching or bent.
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3 The FP-1000/1001 has detected an irrecoverable 

internal error with its firmware.

5 The network module was unable to locate an I/O module 

waiting to be configured. Verify that there are no more 

than nine terminal bases in the bank, and that no terminal 

bases were added to the bank while power was applied.

Table 3-2.  STATUS LED Flashes and Corresponding Error Conditions (Continued)

Number of 

Flashes Error Condition
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Chapter

4Installing and Using the 
FieldPoint Software

This chapter describes how to use the FieldPoint hardware with various 

servers and software packages.

FieldPoint Software Overview

Your FieldPoint software includes a full-functioned configuration 

utility as well as server and driver software for easy integration into 

application software packages. These software components manage the 

low-level communications and hardware details, simplifying 

programmatic access of I/O channels. Version 1.6 of the FieldPoint 

software runs on Windows 95, Windows 98, and Windows NT 4.0 and 

later, and includes the following components:

• FieldPoint Explorer Configuration Utility

• Lookout Driver Class

• BridgeVIEW Server

• LabVIEW VIs

• LabWindows/CVI Functions

• OPC Server

You can download future versions of FieldPoint software from the 

National Instruments FTP site at ftp.natinst.com/support/

fieldpoint/Server. 

FieldPoint Explorer Configuration Utility
FieldPoint Explorer is the configuration utility for FieldPoint hardware 

and software. You can use FieldPoint Explorer to accomplish the 

following tasks:

• Configure the characteristics and hardware of a FieldPoint device 

network

• Configure the tag name space and I/O items of the FieldPoint 

servers

• Write and read I/O values to and from the FieldPoint hardware
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For more information on FieldPoint Explorer, refer to the Using 

FieldPoint Explorer section, later in this chapter.

BridgeVIEW Server
The BridgeVIEW server for FieldPoint provides communication 

between FieldPoint devices and applications you develop using the 

BridgeVIEW graphical programming package for automation. This 

native BridgeVIEW sever allows access to I/O items defined in the 

FieldPoint Explorer. If you prefer, you may also choose to use the OPC 

server to access FieldPoint hardware from BridgeVIEW.

For more information on the BridgeVIEW server, refer to the Using the 

FieldPoint BridgeVIEW Server section, later in this chapter.

Lookout Driver Class
The FieldPoint Lookout driver class allows the Lookout object-based 

automation software package to communicate with the FieldPoint 

devices. This driver class provides a FieldPoint object with connections 

to the tag name space of the I/O items configured in the FieldPoint 

Explorer.

For more information on the Lookout driver class, refer to the Using the 

FieldPoint Lookout Driver Class section, later in this chapter.

LabVIEW VIs
A set of VIs (Virtual Instruments) provide communication between I/O 

items configured in the FieldPoint Explorer and applications you 

develop using the LabVIEW graphical programming environment. A 

set of example applications using these VIs is also provided.

For more information on LabVIEW VIs, refer to the Using the 

FieldPoint LabVIEW VIs section, later in this chapter.

LabWindows/CVI Functions
Applications you develop using the LabWindows/CVI C programming 

environment use a set of C function calls to communicate with I/O items 

configured in the FieldPoint Explorer. An instrument driver with a set 

of function panels and example programs is provided to accelerate your 

development process.
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For more information on LabWindows/CVI functions, refer to the 

Using the FieldPoint LabWindows/CVI Functions section, later in this 

chapter.

OPC Server
OPC (Object Linking and Embedding for Process Control) is an 

industry standard interface that uses Microsoft’s Component Object 

Model (COM). The FieldPoint OPC server provides an interface to the 

I/O items configured in the FieldPoint Explorer and software packages 

that are capable of using OPC, including recent versions of Microsoft’s 

Visual Basic and Visual C/C++ programming environments, and other 

third-party software packages.

For more information on the FieldPoint OPC Server, refer to the Using 

the FieldPoint OPC Server section, later in this chapter.

Other Options for Communicating with FieldPoint Devices
It is also possible to communicate with the FieldPoint system using an 

Optomux-compatible server, or by sending ASCII commands directly 

to and from the serial port of the host computer. Examples of cases 

where one of these methods may be useful include the following:

• Communicating with FieldPoint from a computer running an 

operating system other than Windows 95/98/NT

• Communicating with FieldPoint from a device such as a PLC; to 

integrate FieldPoint devices into an existing Optomux-based 

system

• Using a programming environment that does not support the OPC 

interface

If you choose one of these communication methods, refer to the 

FP-1000/1001 Programmer Reference Manual for details on the protocol 

used by the FieldPoint network modules. You may, however, still use 

the FieldPoint Explorer to configure the FieldPoint devices before 

running your software.

For more information on using FieldPoint with Optomux servers, refer 

to the Using FieldPoint with an Optomux Server section, later in this 

chapter.
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Data Throughput with the FieldPoint Servers
The rate at which data can be transferred between a FieldPoint bank and 

a computer is determined by the number and type of I/O channels and 

the baud rate. You can download a calculator to determine the data 

throughput from ftp.natinst.com/support/FieldPoint/server. 

This calculator is available as both an Excel Spreadsheet and as a 

LabVIEW/BridgeVIEW VI.

Installing FieldPoint Software

Follow these steps to install your FieldPoint software:

1. If you are using BridgeVIEW, LabVIEW, Lookout, or 

LabWindows/CVI with FieldPoint, install these other application 

programs before installing your FieldPoint software. The 

FieldPoint software installation installs the BridgeVIEW server, 

LabVIEW VIs and examples, Lookout driver class, and 

LabWindows/CVI instrument driver only if it finds the 

corresponding application software installed.

2. Insert the FieldPoint Configuration and Server Software disk 

number 1 into the floppy drive on your computer.

3. Click on the Windows Start button, and then click on Run.

4. Enter a:\setup, where a is the letter of your floppy drive, then 

select OK.

5. Follow the onscreen instructions to complete the installation.

Note: Do not worry if the installation program does not ask you to insert all of 

the disks. Depending on the software already installed on your computer, 

you may not need to use all of the disks that you received.

Using FieldPoint Explorer

The FieldPoint Explorer is the configuration software for FieldPoint 

hardware and software. The first step to using FieldPoint software is to 

run the FieldPoint Explorer. You then use FieldPoint Explorer to 

configure the programmable settings of the FieldPoint hardware, such 

as the input range of an analog input module, or watchdog timer 

settings, or the power-up values of output modules. From FieldPoint 

Explorer you define I/O items (which represent one or more physical 

I/O channels) that you want to write to or read from. FieldPoint 

Explorer also provides a user interface from which you can interactively 
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read and write values of these I/O items to verify that your FieldPoint 

system has been correctly installed and configured.

Figure 4-1 shows the parts of the FieldPoint Explorer window.

 

Figure 4-1.  FieldPoint Explorer Window

Getting Assistance While You Work
FieldPoint Explorer includes several features to help answer your 

questions about using the software and to reduce the time you spend 

learning how to use and get the most out of FieldPoint Explorer. These 

features include ToolTips, ScreenTips, and online help. 

ToolTips identify tool bar icons and most items on the screen. Rest your 

pointer over the element you are interested in, and its name appears, as 

shown in Figure 4-2.

List View window shows details
about the group of objects

selected in the DNH window.

Device Network Hierarchy (DNH) Window
shows a tree view of your FieldPoint system,

consisting of the Server, Communications
Resource, Devices, and I/O Items.

Menu and Tool Bars
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Figure 4-2.  ToolTips Showing the Name of an Item

ScreenTips provide descriptions of the items in a dialog box to help 

explain what the item does or how you should use it. Display 

ScreenTips by clicking the question mark button in the title bar of the 

dialog box and then clicking the item you want to know more about. The 

ScreenTip appears as shown in Figure 4-3.

Rest your pointer
over an element
to display ToolTips.
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Figure 4-3.  ScreenTips Showing a Description of an Item

The FieldPoint online help provides complete descriptions of the 

features of FieldPoint Explorer and provides assistance in getting 

started with configuring your FieldPoint hardware and software. Open 

the online help by selecting the Contents option in the Help menu of 

FieldPoint Explorer.

Getting Started with FieldPoint Explorer
This section guides you through an example of how to configure a 

FieldPoint system. The online help provides more details and explains 

all of the features of FieldPoint Explorer.

To get started with FieldPoint Explorer, follow these steps:

1. Install the hardware as described in Chapter 2, Hardware 

Installation and Configuration. Verify that the FieldPoint system is 

powered on and the I/O modules have their READY LEDs lit.

2. From the Windows Start menu, select Programs»FieldPoint» 

FieldPoint Explorer to launch the FieldPoint Explorer program.

3. Add a communications resource to the Device Network Hierarchy. 

To add the resource, first click on the + sign next to IA Server with 

Click this button to 
display ScreenTips.

Then click on the 
element you want 
to learn more about.
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OPC in the DNH window to expand the view. Then right-click on 

the word FieldPoint and select Add a comm resource to this server. 

The communications resource dialog box appears as shown in 

Figure 4-4.

Figure 4-4.  Communication Resource Configuration Window

4. Select the COM port on your computer that you cabled the FieldPoint 

system to. 

The FP-1000/1001 network module is preconfigured for a baud rate 

of 115200 kbps, so you should not have to change the baud rate or 

timeout setting in the dialog box unless you have modified the baud 

rate switches on the network module. The default name for the 

COM port you select is FP Res. 

5. Click on the Find Devices! button to start searching for all of the 

FieldPoint Devices on this communications resource. If no devices 

are found, make sure that the FieldPoint hardware is powered on, 

that the switch settings for the baud rate match the settings on the 

network module, and that no two network modules on the same 

communications port have the same address switch settings. Also 
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make sure that you have selected the COM port to which you have 

connected the FieldPoint system. If FieldPoint Explorer reports that 

it cannot bind the COM port, make sure that you have selected a 

COM port that is properly configured in your computer and is not 

being used by any other program. 

6. After the FieldPoint modules are found, click on the + sign next to 

FP Res in the DNH window to expand the device hierarchy and 

display the modules found on the network. 

The hierarchy should include all of the modules you had connected 

to the communications port. Figure 4-1 shows an example of an 

expanded device hierarchy. The default name of each device found 

includes the model number of the FieldPoint module, followed by 

the @ sign, then the address of the module—for example, “FP-1000 

@0”. For each I/O module found, one I/O Item is created for each 

channel of the module, and one I/O Item is created to represent all 

of the channels on that module collectively.

7. To configure the hardware settings of a particular I/O module, 

select the device in the DNH window. 

a. Right-click on the device name and select Edit the device from 

the pop-up menu. 

b. Click on the Channel Configuration button to bring up the 

channel configuration dialog box shown in Figure 4-5. In this 

example, an FP-TC-120 thermocouple module was selected to 

configure. 

c. To configure a channel, select the channel in the Channel 

Number list. 

d. Set the attributes of this channel from the Attributes tab by 

selecting the desired Attribute Value from the list. 

e. Set the data range for this channel by clicking on the Ranges 

tab and selecting the range from the list. 

f. Continue this for each channel in the Channel Number list that 

you want to configure. 

g. Click the OK button when you are finished. 

h. Click the Yes button when asked if you want to write these 

settings to the device.
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Figure 4-5.  Channel Configuration Dialog Box

8. You can now try to read from the FieldPoint devices that you have 

configured. Select one of the devices in the DNH window, and then 

click on the Start Monitoring button (green arrow icon) in the Tool 

Bar to start monitoring the items of that device. 

The tag symbols of the items in the list view window turn blue to 

show that they are being monitored. The Value column in the list 

view window should show the current value of the I/O channels 

defined by the I/O Items, and the Status column shows any error 

conditions received while communicating with the FieldPoint 

network. 

9. Click on the Stop Monitoring button (red square icon) in the 

toolbar to stop monitoring the items. 

10. You can also write to output channels of I/O Items that you have 

configured. 

a. Select a device in the DNH window with output channels.
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b. Select the I/O Item in the list view window corresponding to 

the channel you want to write to. 

c. Click on the Write Value button (pen and paper icon) in the 

toolbar to write to the I/O channel(s) represented by the I/O 

Item. 

d. Enter the value you want to write in the Value box and click on 

the Write! Button to write the value out. The value must be in 

the range of the channel that you configured in Step 7. For 

example, if the channel was configured for a range of 0.0035 A 

to 0.021 A, and you want to write a value of 0.010 A (10 mA), 

enter 0.010 in the Value box. For discrete I/O channels with a 

Boolean range, enter a 1 or a 0 in the Value box.

11. When you are satisfied with the hardware configuration of your 

FieldPoint system, you may choose to save this configuration as the 

new power-up state for the hardware. 

a. Edit the device configuration of the FP-1000/1001 network 

module by right-clicking on the network module entry in the 

DNH window.

b. Select Edit this device from the pop-up menu. 

c. Make sure that the factory configuration checkbox is not 

checked. 

d. If you only want the range and attribute settings you configured 

in Step 7 to be saved as power-up states, you can just click on 

the OK button, because these settings get written to the 

non-volatile memory of the network module when you write 

changes to the device in Step 7. 

e. If you also want to save all of the current output states of the 

output channels, click the Snapshot! button to store all of the 

output values of that bank of FieldPoint modules to the 

power-up memory of the network module, then click the OK 

button when you are finished.

12. When you are finished configuring the hardware settings and the 

I/O items, you must save your configuration file. Select File»Save 

from the menu bar. 

13. Exit the FieldPoint Explorer application. 

Note: You must exit FieldPoint Explorer before you can communicate with the 

FieldPoint system using one of the methods described in the subsequent 

sections.
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Using the FieldPoint BridgeVIEW Server

The FieldPoint BridgeVIEW server is a device server based on the 

native BridgeVIEW server architecture. The I/O Items you configured 

in the FieldPoint Explorer become available to the BridgeVIEW server 

when you export the configuration data from FieldPoint Explorer into 

the BridgeVIEW common configuration database (CCDB). From 

within BridgeVIEW, the Tag Configuration Wizard imports this 

configuration information, creating a tag for every I/O Item you 

configured in the FieldPoint Explorer. These tags are immediately 

accessible through the BridgeVIEW real-time database.

To start using the FieldPoint server with BridgeVIEW, follow these 

steps:

1. Configure and test your FieldPoint server from FieldPoint 

Explorer, as described in the Using FieldPoint Explorer section of 

this chapter, and save your configuration file. 

2. Select the BridgeVIEW»Export to BridgeVIEW option from the 

menu bar of FieldPoint Explorer to export the current configuration 

file that you just saved to BridgeVIEW’s active CCDB. (If 

BridgeVIEW is not an option on your FieldPoint Explorer’s menu 

bar, make sure that you have installed the FieldPoint software after 

installing BridgeVIEW.)

Note: If you edit, rename, or move your configuration file after you export it to 

the BridgeVIEW Active CCDB, you must re-export the new configuration 

file. If you select another CCDB file as the Active CCDB for BridgeVIEW, 

you must re-export your FieldPoint configuration file to the newly selected 

Active CCDB file.

3. Exit FieldPoint Explorer. 

Note: You must exit FieldPoint Explorer before you can use the FieldPoint server 

from BridgeVIEW.

4. Launch BridgeVIEW and load the Tag Configuration Editor by 

selecting Project»Tag»Configuration from the menu bar of a 

BridgeVIEW window, or click on the Configure Tags button of 

BridgeVIEW’s initial tile screen.

5. Click on the Configuration Wizard button in the lower-right corner 

of the Tag Configuration Editor window, and then select FieldPoint 

from the list of servers that appears. 
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All of the FieldPoint I/O Items in your configuration file are 

automatically imported as tags into BridgeVIEW and are now 

accessible through the BridgeVIEW real-time database. Do not 

worry if you get a message that no tags were created for the network 

modules in your system, as they do not have any I/O items.

6. You may edit the tags to change their names, scaling information, 

and other parameters. 

Refer to your BridgeVIEW documentation for more information 

about tags and their configuration. Hint: the Tag Configuration 

Editor may be easier to read for FieldPoint tags if you change the 

middle column heading from Tag Group to Item.

7. When you have finished editing the tags (or if you chose to keep the 

default settings for the tags), exit the Tag Configuration Editor and 

save the changes to the configuration file. 

You can now access the FieldPoint I/O Items by reading or writing 

these tags as you would any other tag in BridgeVIEW.

Using the FieldPoint Lookout Driver Class

When you install the FieldPoint software, a FieldPoint driver class is 

created if Lookout has already been installed on your computer. When 

you create a FieldPoint object within Lookout, you specify the 

configuration file created by FieldPoint Explorer. The FieldPoint object 

you create uses this configuration file to import the information about 

the I/O items that you had configured within FieldPoint Explorer. All of 

these I/O Items are immediately accessible as writable and/or readable 

data members.

To start using the FieldPoint Lookout driver class, follow these steps:

1. Configure and test your FieldPoint server from FieldPoint 

Explorer, as described in the Using FieldPoint Explorer section of 

this chapter, and save your configuration file.

2. Exit FieldPoint Explorer. 

Note: You must exit FieldPoint Explorer before you can use the FieldPoint driver 

class from Lookout.

3. Start Lookout, and create a new control panel or open an 

existing one.
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4. Select Object»Create from the menu bar and choose the FieldPoint 

object class from the Drivers category of the Select Object Class 

dialog box. The Create FieldPoint Secondary dialog box shown in 

Figure 4-6 appears.

Figure 4-6.  Creating the FieldPoint Object

5. Create your object.

a. Select the serial port you are using and the data rate (baud rate) 

in the Communication Settings area of the dialog box. 

b. Enter the path of the configuration file you saved from 

FieldPoint Explorer in the IAK Configuration File area, and 

make sure the Import alias information box is checked. (You 

can use the Browse button to find the configuration file you 

saved.) 

c. Make any changes you want to make to the poll rate or other 

parameters, and click on the OK button.
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Your FieldPoint object is now created, and all of the I/O Items you 

configured in FieldPoint Explorer are available as data members of 

the object. 

6. To verify that the data members were properly imported from your 

configuration file, or to modify the parameters of the data members, 

select Object»Edit Database from the menu bar, and double-click 

on the FieldPoint object you just created. An object database 

window like the one in Figure 4-7 appears.

Figure 4-7.  Modifying the FieldPoint Data Members

The Configured Points list should contain all of the I/O Items you 

configured in FieldPoint Explorer. The Eng. units in the scaling 

window indicate the configured range of analog I/O Items. From this 

window, you can modify the alias, alarm conditions, and other 

parameters of each data member in the FieldPoint object.
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For more information about the FieldPoint driver object class and data 

members, refer to the National Instruments FieldPoint section of 

Chapter 18, Object Class Reference, in your Lookout Reference Manual.

Using the FieldPoint LabVIEW VIs

When you install the FieldPoint software, a library of FieldPoint VIs is 

created if LabVIEW has already been installed on your computer. The 

FieldPoint VIs (FP Open, FP Get Configuration Info, FP Create Tag, FP 

Advise, FP Read, FP Write, and FP Close) directly access the I/O Items 

you configured in the FieldPoint Explorer program. In addition, a set of 

examples is placed in your LabVIEW Examples directory. These 

examples are the best way to get familiar with the LabVIEW VIs. The 

FieldPoint LabVIEW Help document is in the same program group on 

your Windows taskbar as the FieldPoint Explorer program. This help 

document explains how to use the FieldPoint VIs.

A simple FieldPoint application to read an I/O Item may only need to 

use four of the VIs. To create an example of such an application, 

complete the following steps and refer to Figures 4-8 and 4-9. This 

application reads the inputs from the I/O Item named All shown in 

Figure 4-1.

1. Use FP Open to open the server. By default, the server opens with 

the configuration file you last saved with FieldPoint Explorer.

2. Use FP Create Tag to create a handle to an I/O Item that you defined 

in FieldPoint Explorer. You provide three string names to this VI 

to indicate which I/O Item you want access to. These three strings 

are the names given to the communications resource, the device, 

and the I/O item. Figure 4-7 shows default names as they may 

appear when you use the Find Devices button in FieldPoint 

Explorer.

3. Use FP Advise to continuously monitor the I/O Item at the rate 

specified in FieldPoint Explorer. (You may also set a new rate with 

this VI.) In this example, the while loop executes at this advise rate. 

If you used FP Read VI here instead of FP Advise, the loop would 

free-run at the fastest rate it could sustain, reading the I/O Item over 

the serial port each time the loop ran.

Note: You should not put more than one FP Advise VI in a loop. All VIs in a loop 

execute only once each time a loop runs, and FP Advise VIs only complete 

at their advise rate. If you had more than one FP Advise VI in the loop, the 

loop (and therefore all of the FP Advise VIs in the loop) would only execute 
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at the slowest rate of the Advises. The loop may not execute at all if any of 

the Advises is set to complete “On Data Change”, and the data of the 

corresponding I/O Item never changed.

4. Use FP Close to close the server. This action also stops all pending 

Advise operations. 

Note: This example reads the value of an I/O Item value from the FieldPoint 

device. To write to an Output Item, use FP Write instead of FP Advise (or 

FP Read).

Figure 4-8.  LabVIEW Diagram for LabVIEW Example Application
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Figure 4-9.  Front Panel for LabVIEW Example Application

Using the FieldPoint LabWindows/CVI Functions

When you install the FieldPoint software, a LabWindows/CVI 

instrument driver for FieldPoint is created if LabWindows/CVI has 

already been installed on your computer. This instrument driver 

includes function panels to call C functions that directly access the I/O 

Items you configured in the FieldPoint Explorer program. In addition, 

a set of sample projects is placed in your LabWindows/CVI Samples 

directory. These examples are the best way to get familiar with these 

functions. The FieldPoint CVI Help document is in the same program 

group on your Windows taskbar as the FieldPoint Explorer program. 

This help document describes each function in the instrument driver 

with a description of the C syntax, a description of each parameter, and 

a list of possible error codes.

Note: FieldPoint CVI Interface Compatibility Modes: The FieldPoint software 

ships with object (.obj) files to support the different compiler compatibility 

modes that LabWindows/CVI supports (Microsoft Visual C/C++, Borland, 

Watcom, and Symantec). When FieldPoint software is installed, the 

Microsoft compatibility mode is installed by default. To use an alternate 
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compatibility, copy the supplied .obj file from the compiler folder (for 

instance, /CVI/FieldPoint/borland/FieldPoint.obj) with which you 

would like compatibility to the /FieldPoint subdirectory of the CVI 

directory.

Using the FieldPoint OPC Server

OPC (OLE for Process Control) is an industry standard device interface 

specification that provides interoperability between field devices such 

as FieldPoint and application software packages. The FieldPoint OPC 

server, like the other FieldPoint interfaces, imports the I/O Items that 

you configured in FieldPoint Explorer and makes them available as 

OPC Items to an OPC client, a software program designed to 

communicate with OPC servers. The FieldPoint OPC server allows any 

application written as an OPC client to access the FieldPoint hardware 

over the serial port. Because OPC is based in part on Microsoft’s 

DCOM (Distributed Component Object Model), it is even possible for 

an OPC client on one computer to access FieldPoint hardware 

connected to the serial port of another computer if the two computers 

are networked together. 

OPC clients may differ in the features they offer and their presentation 

of the OPC interface for the FieldPoint OPC server. You should refer to 

the documentation on using the OPC client features of your application 

for detailed instructions on how to access an OPC server. However, the 

basics steps involved are similar for most OPC client applications. 

Follow these steps to start using the FieldPoint OPC server:

1. Open the FieldPoint OPC server, National 

Instruments.OPCFieldPoint. 

This server was registered with Windows when you installed the 

FieldPoint software. OPC Clients should be able to show you a list 

of available registered servers, but you may have to type this name 

in yourself. The OPC client may automatically connect to the server 

when you select it, but if you are given the option to explicitly 

connect to the FieldPoint OPC server, you should do so.

2. Create a group. 

Groups are a collection of I/O items. Some OPC clients may not 

give you the option of creating groups, or they may be created for 

you.
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3. Select the I/O Items, which you configured in FieldPoint Explorer, 

that you want to read or write as a part of this group. 

Many OPC clients can use the “Browse Address Space” feature of 

the FieldPoint OPC Server to show you a list of all of the I/O Items 

you configured in FieldPoint Explorer. However, if the OPC client 

you are using does not support this feature, you may need to type 

the Item IDs of the I/O Items directly. The naming convention of 

the FieldPoint Item IDs is [Comm resource name]\[Device 

Name]\[I/O Item name] where the Comm resource, Device, and 

I/O Item names are the names given in FieldPoint Explorer. For 

example, an Item ID associated with one of the I/O Items shown in 

Figure 4-1 would be FP Res\FP-TC-120 @1\Channel 0.

In most cases, the preceding steps are all that is required to configure an 

OPC client to read from I/O items of the FieldPoint OPC server. In some 

cases, the OPC client may require more information about the 

FieldPoint OPC server. The following list contains additional 

information about the FieldPoint OPC server, which you may find 

helpful.

• The FieldPoint OPC Server does not require an Access Path. Some 

OPC clients may expect the access path to be included in the 

Item ID name or may request the access path when you select I/O 

Items. You should be able to leave the access path blank (empty 

string).

• The FieldPoint OPC custom interface is an out of process server.

• The FieldPoint OPC Server supports both synchronous and 

asynchronous reads and writes.

• The FieldPoint OPC Server uses the “GetErrorString” method to 

return error and diagnostic messages from the FieldPoint server and 

hardware. OPC clients that do not support this method may only 

give you error messages like “Bad, non-specific” along with an 

error code. Some OPC clients that do not support this 

“GetErrorString” method may still provide a way for you to 

manually look up the FieldPoint message corresponding to the error 

code using the method.
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Using FieldPoint with an Optomux Server

The FP-1000/1001 supports many of the commands of the standard 

Optomux protocol, so it is possible to communicate with the FieldPoint 

hardware using an Optomux server. This may be appropriate for an 

application where you are integrating FieldPoint into a system that is 

already using an Optomux server, or if you are using FieldPoint with an 

operating system not compatible with the other software options 

provided with your FieldPoint software. (The FieldPoint software does 

not include a generic Optomux server.) The FP-1000/1001 

Programmer Reference Manual has detailed information on the 

protocol used by the FP-1000/1001, including which standard Optomux 

commands are supported and which are not. It is also a reference for 

working with the ASCII protocol directly. However, a general overview 

of using FieldPoint with Optomux servers is provided here as a guide.

• Standard Optomux commands do not allow for the configuration of 

hardware settings, so you must use FieldPoint Explorer to set your 

hardware settings (such as are set in Step 7 in the Getting Started 

with FieldPoint Explorer section, earlier in this chapter). If you 

make these settings the default power-up settings for the hardware 

(as described in Step 10 of that section), the FP-1000/1001 network 

module always powers up the I/O modules to these settings, so you 

do not need to run the FieldPoint Explorer more than once to 

configure your network module.

• The Optomux address of the FP-1000/1001 network module is the 

network address set by the switches as described in Table 2-1, 

Network Address Switch Settings for the FP-1000/1001, in 

Chapter 2, Hardware Installation and Configuration. The 

Optomux address of the I/O module in the first terminal base 

attached to the network module is one plus the address of the 

network module, and so on. In most cases you do not need to 

communicate with the network module, expect perhaps to change 

watchdog timer settings.

• Optomux analog data contains only 12 bits of resolution and is 

usually represented as an integer from 0 to 4095. Data that is 

returned from a FieldPoint analog channel has its minimum value 

represented by 0 and its maximum value represented by 4095. In 

some cases Optomux data may be represented by integers from 

4096 (representing the minimum value of an analog channel) to 

8191 (representing the maximum value of an analog channel).
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• The standard Optomux protocol is not capable of returning the full 

range of error and diagnostic features supported by FieldPoint 

modules. 

• If you are writing your own server, sending and receiving messages 

directly using the serial port, you are highly encouraged to use the 

extended FieldPoint command set as described in the FP-1000/1001 

Programmer Reference Manual to get the most out of your 

FieldPoint hardware. Examples of programs that directly access the 

serial port to communicate with the FieldPoint network modules 

are available on the National Instruments FTP site at 

ftp.natinst.com/support/fieldpoint/Examples/. 
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Appendix

ASpecifications

This appendix describes the specifications of the FP-1000 and FP-1001 

network modules.

All FieldPoint network modules undergo extensive testing for operating 

under rugged environmental conditions that exist in industrial 

applications. FieldPoint network modules are designed and tested for 

immunity and susceptibility, as well as for emissions. 

Network
FP-1000 ..............................................1 RS-232 port, 1 RS-485 

repeater port

FP-1001 ..............................................1 RS-485 port

Baud Rates..........................................300, 1200, 2400, 9600, 19200, 

38400, 57600, 115200 

(switch-settable)

Communication Parameters ................1 start bit, 8 data bits, 1 stop bit, 

no parity

Integrity ..............................................Checksum

Cabling Distance from Host*

  FP-1000 .....................................50 ft. (nominal)*

  FP-1001 .....................................4000 ft. (nominal)*

* Refer to the RS-232 Interface Specifications and RS-485 Interface 

Specifications sections in Chapter 2, Hardware Installation and 

Configuration.

Power Supply Range ...........................11 to 30 VDC

Power Consumption ............................1 watt + 1.15 * ∑(I/O Module 

Consumption)

Maximum Terminal Bases per Bank ...9
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Maximum Number of Banks .............. 25

RS-232/RS-485 Interface Chips ......... 15 kV ESD, low noise and slew 

rate, limited interface ICs

RS-485 Isolation ................................ 2500 Vrms breakdown,

250 Vrms operational

Environment
Operating Temperature....................... –40° to +70° C

Storage Temperature .......................... –55° to +90° C 

Relative Humidity .............................. 5% to 90% noncondensing 

Compliance
Electrical Safety ................................. designed to meet IEC 1010

EMI Emissions/Immunity................... CISPR 11
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Appendix

BCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer your 

questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 

provide the information you need. Our electronic services include a bulletin board service, an FTP site, 

a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 

electronic support systems. If the information available on these systems does not answer your 

questions, we offer fax and telephone support through our technical support centers, which are staffed 

by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 

and documents to answer most common customer questions. From these sites, you can also download 

the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 

the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 

access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files and 

documents are located in the /support directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 

512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 

Internet address listed below. Remember to include your name, address, and phone number so we can 

contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, contact 

the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Québec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



FieldPoint System Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 

Complete a new copy of this form each time you revise your software or hardware configuration, and 

use this form as a reference for your current configuration. Completing this form accurately also helps 

us to answer your questions more efficiently.

Host Computer

Computer brand ________________ Model ________________ Processor __________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter __________________________

Mouse ___yes   ___no    Mouse type _________________________________________________

National Instruments application software product ______________________ Version _________

Other application software product ___________________________________ Version ________

National Instruments server _________________________________________ Version ________

Other installed software that may use serial ports _______________________________________

_______________________________________________________________________________

Serial adapter (COM port or adapter card) used ________________________________________

     Configuration _________________________________________________________________

Serial driver ______________________________________________________ Version _______

     Configuration _________________________________________________________________

Serial port timeout value _____________ ms

Number of FieldPoint banks _______

FieldPoint Software

List the applications and/or servers that you are using with the FieldPoint hardware ____________

_______________________________________________________________________________

COM Port 

Number Baud Rate

Data Bits/Stop Bits/

Parity

 Serial Hardware That 

Uses This Port TX/RX FIFOs



FieldPoint Banks
Please use one page per FieldPoint bank.

Network module _____________________________________ Firmware revision ____________

Address __________________________________________ Baud rate ___________________

Circle the state of the following items when your problem occurs:

LEDs     POWER: ON/OFF     NETWORK: ON/OFF     ACCESS: ON/OFF     STATUS: ON/OFF

SnapShot feature Enabled/Disabled

Watchdog timer Enabled/Disabled     Timeout value _______ ms

Number of FieldPoint terminal bases ________________________________________________

Number of FieldPoint I/O modules __________________________________________________

Base

# Module Name*

POWER 

LED

READY 

LED Module Configuration Information

0 FP-1000/1001 ON/OFF ON/OFF

1 ON/OFF ON/OFF

2 ON/OFF ON/OFF

3 ON/OFF ON/OFF

4 ON/OFF ON/OFF

5 ON/OFF ON/OFF

6 ON/OFF ON/OFF

7 ON/OFF ON/OFF

8 ON/OFF ON/OFF

9 ON/OFF ON/OFF

* If a terminal base is present but no module is inserted, write “none.”



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 

the completed copy of this form as a reference for your current configuration. Completing this form 

accurately before contacting National Instruments for technical support helps our applications 

engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand_________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 

This information helps us provide quality products to meet your needs.

Title: FieldPoint™ FP-1000 /1001 User Manual

Edition Date: August 1998

Part Number: 321631B-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Phone (___)__________________________  Fax (___) __________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX  78730-5039
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Glossary

% percent

° degrees

0x precedes a hexadecimal number

Ω ohms

b bits

B bytes

bank The combination of one FieldPoint network module and one or more 

terminal bases and I/O modules.

bps bits per second

C celsius

CISPR International Special Committee On Radio Interference

DSR Data Set Ready

EDS electronic data sheet

EMI electromagnetic interference

ESD electrostatic discharge

Prefix Meanings Value

m- milli- 10–3

k- kilo- 103

M- mega- 106
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FIFO first-in-first-out

ft. feet

FTP file transfer protocol

g grams

HotPnP Hot Plug and Play

Hz hertz

IEC International Electrotechnical Commission

in. inches

I/O input/output

LED Light-emitting diode

OPC OLE for Process Control

POST power-on self test

RAM random-access memory

RTS Request to Send

V Volts

VDC Volts direct current

Vrms Volts root mean squared
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Index

A
ACCESS LED, 2-17, 3-7, 3-8

addresses, setting

network address, 2-12 to 2-14

switches (figure), 2-14

unique address for each module (note), 2-13

B
bandwidth, data, 4-5

banks. See FieldPoint banks.

baud rate

address and baud rate switch location 

(figure), 2-12

baud rate switch settings (table), 2-15

biasing resistors for RS-485 port, 2-10

BridgeVIEW server, using with FieldPoint, 4-2, 

4-12 to 4-13

bulletin board support, B-1

bus, high-speed local, 3-1

C
cable lengths, 2-8, 2-10

configuration of FieldPoint software, 4-1, 

4-4 to 4-11

configuration of network module

address and baud rate selection, 

2-12 to 2-15

baud rate settings, 2-15

network address settings, 2-13 to 2-14

configuration, saving for FieldPoint bank, 

3-2 to 3-4

connections

network connections

FP-1000, 2-7 to 2-8

FP-1001, 2-8 to 2-12

serial port connections, 2-7 to 2-12

isolation of RS-485 interface (note), 

2-9 to 2-10

RS-232 interface specifications, 2-8

RS-485 interface specifications, 2-10

terminal base connection

with DIN rail mounting, 2-3

with panel mounting, 2-5 to 2-6

connector pinouts

power connector (figure), 2-16

RS-232 ports (figure), 2-8

RS-485 ports (figure), 2-10

customer communication, B-1 to B-2, xi

D
DIN rail

connecting terminal bases on, 2-3

mounting network module on, 2-1 to 2-2

rail clip, 2-1, 2-2

removing network module from, 2-4

distances, 2-8, 2-10

documentation

conventions used in manual, x-xi

how to use manual set, ix

organization of manual, x

related documentation, xi
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E
electronic support services, B-1 to B-2

e-mail support, B-2

environment specifications, A-2

error conditions indicated by STATUS LED 

(table), 3-8 to 3-9

Explorer, FieldPoint, 4-2, 4-4 to 4-12

F
fax and telephone support, B-2

fax-on-demand support, B-2

feature set description, 3-1 to 3-9

high-speed local bus, 3-1

HotPnP (Hot Plug and Play), 3-4 to 3-7

LED indicators, 3-7 to 3-9

network watchdog timer, 3-1 to 3-2

power-on self test (POST), 3-7

Programmable Power-Up State, 

3-3 to 3-4

SnapShot feature, 3-2 to 3-3

FieldPoint banks

calculating power for bank, 2-16

maximum number of banks, 1-2

network watchdog timer, 3-1 to 3-2

SnapShot feature, 3-2 to 3-3

FieldPoint network modules. See also feature 

set description.

overview, 1-1 to 1-2

specifications, A-1 to A-2

FieldPoint software, 4-1 to 4-22

BridgeVIEW server, 4-2, 4-12 to 4-13

configuring, 4-1, 4-1 to 4-11

FieldPoint Explorer, 4-2, 4-4 to 4-12

installing, 4-4

LabVIEW VIs, 4-2, 4-16 to 4-18

LabWindows/CVI functions, 4-2 to 4-3, 

4-18 to 4-19

Lookout driver class, 4-2, 4-13 to 4-16

OPC server, 4-3, 4-19 to 4-20

Optomux Servers, 4-3, 4-2 to 4-22

overview, 4-1 to 4-3

FP-1000

configuring, 2-12 to 2-15

connecting to computer, 2-7 to 2-8

connection to RS-232 port, 1-2

power connections, 2-5 to 2-7

FP-1001

configuring, 2-12 to 2-15

connecting to network, 2-8 to 2-12

connection to RS-485 port, 1-2

power connections, 2-5 to 2-7

FTP support, 4-1,B-1

H
HotPnP (Hot Plug and Play), 3-4 to 3-7

inserting new I/O modules, 3-5

module configuration results after 

HotPnP replacement (table), 3-6

during operation, 3-5 to 3-7

overview, 3-4 to 3-5

during power-up, 3-5

replacing I/O modules, 3-5 to 3-7

I
installation, 2-1 to 2-17. 

connecting to computer

FP-1000, 2-7 to 2-8

FP-1001, 2-8 to 2-12

mounting on DIN rail, 2-1 to 2-4

mounting to panel, 2-4 to 2-6

HotPnP (Hot Plug and Play) features, 

3-4 to 3-6

network module installation, 2-1 to 2-2

power connections, 2-15 to 2-16

removing network module

from DIN rail, 2-4

from panel, 2-6
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serial port connections, 2-7 to 2-129

isolation of RS-485 interface (note), 

2-9 to 2-10

RS-232 interface specifications, 2-8

RS-485 interface specifications, 2-10

terminal base connection

with DIN rail mounting, 2-3

with panel mounting, 2-5 to 2-6

I/O modules

inserting new, 3-5

installing onto terminal bases, 2-6 to 2-7

module configuration results after 

HotPnP replacement (table), 3-6

replacing, 3-5 to 3-7

saving power-up configuration, 3-2 to 3-4

Isolation, 2-9 to 2-10

L
LabVIEW VIs, FieldPoint, 4-2, 4-16 to 4-18

LabWindows/CVI functions, FieldPoint, 

4-2 to 4-3, 4-18 to 4-19

LED indicators, 3-7 to 3-9

local bus, high-speed, 3-1

Lookout driver class, FieldPoint, 4-2, 

4-13 to 4-16

M
manual. See documentation.

mounting. See installation.

N
network address, setting, 2-2 to 2-4

NETWORK LED, 3-7, 3-8

network module. See FieldPoint network 

modules.

network termination and biasing, RS-485 

ports, 2-10 to 2-12

network watchdog timer, 3-1 to 3-2

O
OPC server, FieldPoint, 4-3, 4-19 to 4-20

Optomux protocol, 1-2

Optomux servers, using with FieldPoint, 4-3, 

4-21 to 4-22

P
panel mounting

connecting terminal bases on, 2-5 to 2-6

mounting network module on, 2-4 to 2-5

removing network module and terminal 

bases from, 2-6

pinouts. See connector pinouts.

power connections, 2-15 to 2-16

calculating power for FieldPoint 

bank, 2-16

pinout (figure), 2-16

POWER LED, 2-17, 3-7, 3-8

power-on self test (POST), 3-7

Programmable Power-Up State, 3-3 to 3-4

R
rail clip, locking (figure), 2-1

removing FieldPoint network module

from DIN rail, 2-4

from panel, 2-6

removing terminal bases from panel, 2-6

RS-232 ports

connector pinout (figure), 2-8

FP-1000 connection to, 1-2, 2-7 to 2-8

interface specifications, 2-8

RS-485 ports

connector pinout (figure), 2-10

FP-1001 connection to, 1-2, 2-8 to 2-10

interface specifications, 2-10

isolation from FieldPoint system 

(note), 2-9 to 2-10
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network termination and biasing, 

2-10 to 2-12

typical signal connections (figures), 

2-11 to 2-12

S
safety isolation, 2-9 to 2-10

serial ports. See RS-232 ports; RS-485 ports.

SnapShot feature, 3-2 to 3-3

software. See FieldPoint software.

specifications, A-1 to A-2

compliance, A-2

environment, A-2

network, A-1 to A-2

STATUS LED, 2-17, 3-8

switches

address and baud rate switch 

(figure), 2-12

baud rate switch settings (table), 2-15

network address switch settings 

(table), 2-14

T
technical support, B-1 to B-2

telephone and fax support, B-2

terminal base connection

with DIN rail mounting, 2-3

with panel mounting, 2-5 to 2-6

termination and biasing, RS-485 ports, 

2-10 to 2-12

throughput, 4-3

U
update rate. See throughput.

W
watchdog timer, 3-1 to 3-2
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